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About This Book

Subject

Audience

This book describes the objects in the PowerBuilder Foundation Class
Library (PFC). Each object’s discussion includes:

¢ A diagram providing a quick overview of the object’s capabilities
¢ Instance variables
¢ Events and user events

¢ Object functions

Online Help

The PFC online Help (pbpfc60.hlp) contains all the objects, events, and
functions explained in this book. This Help file includes customized
buttons and links to help you navigate through inheritance hierarchies
and related objects.

FOR INFO For PFC usage information, see the PowerBuilder
Foundation Class Library User’s Guide.

This book is for experienced PowerBuilder developers. It assumes that:

¢ You are currently developing applications using PowerBuilder and
understand the concepts and techniques described in the
PowerBuilder Application Techniques book

¢ You understand SQL and how to use your site-specific DBMS

ix






CHAPTER 1 Object Reference Conventions

About this chapter This chapter describes the conventions used in this manual and the PFC
online Help file.



Naming conventions

Naming conventions

Object naming PFC uses the following prefix standard for object names:
conventions
pfcobject_type_objectname
where:

¢ pfcobject indicates whether the object is part of the PFC level or the
extension level. Objects that are part of the PFC level have the prefix
PFC_

¢ rype indicates the object type
This table describes the object types.

Prefix | Description

m_ Menu

n_ Standard class user object
n_cst Custom class user object
S_ Global structure

u_ Visual user object

w_ Window

For example:
¢ Pfc_w_master is the master window and is in the PFC level
¢ Pfc_u_tvsis the TreeView visual user object and is in the PFC level

¢ U_dw is the DataWindow visual user object and is in the extension
level

¢ N_cst_dwsrv is the custom class user object for DataWindow services
and is in the extension level

¢ N_tr is the transaction standard class user object and is in the extension
level

Variable naming PFC uses the following standard for variable names:
conventions

<scope><datatype>_variablename

Scope is one of the following:

Prefix | Description

a | Argument to an event or function
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Prefix

Description

g

Global variable

i

Instance variable

1

Local variable

S

Shared variable

For standard data types, datatype is one of the following:

Prefix Description
a Any

blb Blob

b Boolean

ch Character

d Date

dtm DateTime

dc Decimal

dbl Double

e Enumerated

i Integer

1 Long

r Real

S String

tm Time

ui UnsignedInteger
ul UnsignedLong

For reference variables, datatype is one of the following:

Prefix Description
app Application
ab ArrayBounds
cbx CheckBox
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Prefix Description

cb CommandButton

cd ClassDefinition

cdo ClassDefinitionObject

cn Connection

cninfo ConnectionInfo

cno ConnectObject

cxk ContextKeyword

cxinfo ContextInformation

cpp cplusplus

ds DataStore

dw DataWindow

dwc DataWindowChild

drg DragObject

drw DrawObject

ddplb DropDownPictureListBox
ddlb DropDownListBox

dwo DWobject

dda DynamicDescriptionArea
dsa DynamicStagingArea

ed EnumerationDefinition
eid EnumerationltemDefinition
em EditMask

env Environment

err Error

ext ExtObject

gr Graph

g0 GraphicObject
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Prefix Description

grax GrAxis

grda GrDispAttr

gb GroupBox

hsb HorizontalScrollBar
inet Inet

ir InternetResult

In Line

Ib ListBox

Iv ListView

Ivi ListViewltem

mfd MailFileDescription
mm MailMessage

mr MailRecipient

ms MailSession

mdi MDIClient

m Menu

mc MenuCascade

msg Message

mle MultiLineEdit

nv NonVisualObject
oc OleControl

00 OleObject

ostg OleStorage

omc OmControl

omcc OmCustomControl
omec OmEmbeddedControl
omo OmObject




Naming conventions

Prefix Description
omstm OmStream
omstg OmStorage

oval Oval

P Picture

pb PictureButton
pbcpp PBToCPPObject
plb PictureListBox
pl Pipeline

po PowerObject
procall ProfileCall
proclass | ProfileClass
proln ProfileLine
prort ProfileRoutine
pro Profiling

rb RadioButton

rec Rectangle

rem RemoteObject
rte RichTextEdit
rrec RoundRectangle
rteo RteObject

scrd ScriptDefinition
sle SingleLineEdit
srv Service

st StaticText

std SimpleTypeDefinition
str Structure

tab Tab
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Prefix Description

tabpg TabPage

tcan TraceActivityNode
tcbe TraceBeginEnd

tcerr TraceError

tef TraceFile

tcln TraceLine

tcge TraceGarbageCollect
tco TraceObject

tert TraceRoutine

tesql TraceSQL

tct TraceTree

tctn TraceTreeNode
tcterr TraceTreeError
tetsql TraceTreeSQL

tetge TraceTreeGarbageCollect
tctln TraceTreeLine

tcto TraceTreeObject
tetrt TraceTreeRoutine
tctu TraceTreeUser

tcu TraceUser

td TypeDefinition

tr Transaction

trp Transport

tv TreeView

tvi TreeViewltem

uo UserObject

vred VariableCardinalityDefinition




Naming conventions

Prefix Description
vrd VariableDefinition
vsb VerticalScrollBar
) WindowObject
w Window
Function naming Global functions use the f_ prefix and object functions use the of _ prefix.

conventions
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Online Help

Accessing Help

Navigating through
the Help file

Using the Powersoft
Online Books

The PFC online Help file contains all information found in this manual, as well
as hypertext links among related topics. There are many ways to access this
file:

¢ From the PowerBuilder Help Contents tab (Windows 95 and
Windows NT only) The PowerBuilder Help screen includes a jump to

PFC Help.

¢ Double-click the filename (pbpfc60.hip) from the Explorer or File
Manager This displays the Contents tab, which you can use to view
lists of objects.

¢ Using SHIFT+F 1 from the PowerScript editor (Windows 95 and
Windows NT only) This displays Help for the selected object function
or event.

The PFC Help file provides many helpful links among objects, functions, and
events:

¢ From an object You can display a dialog box with jumps to instance
variables, events, and functions. You can also:

¢ Click the See Also button to jump to related objects and the
Powersoft Online Books, if available to your workstation.

¢ Click the Descendants button to display a list of descendants, if any
¢ Click the Ancestor button to jump to the ancestor object

¢ From an event or function You can display a code example, if
appropriate, for the event or function. You can also:

¢ Click the See Also button to jump to related objects and the
Powersoft Online Books, if available to your workstation.

¢ Click the Object button to jump to the parent object

Most online Help topics include a jump to related topics in the Powersoft
Online Books. To use the Powersoft Online Books, you must have installed
software on your workstation, and have access to the files containing the
Online Books (typically either on the PowerBuilder Online Documentation CD
or a network drive).



Sample application and code examples

Sample application and code examples

Sample application

Code examples

10

The PEAT sample application shows you how to use PFC for a simple project
estimation and tracking system. Its includes examples of windows,
DataWindows, tabs, TreeViews, ListViews, and custom class user objects.

The EXAMPFC code examples application shows you how to use selected
PFC objects and services. Its includes examples of application services,
windows, window services, DataWindows, DataWindow services, tabs,
TreeViews, ListViews, and custom class user objects.

By default, the code examples are installed in the PFC\Examples directory.
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About this chapter

Contents

Window Objects

This chapter describes the base-class windows in the PowerBuilder
Foundation Class Library (PFC). Each discussion includes information on
usage, instance variables, events, and functions.

The windows are listed in alphabetical order. Each window’s discussion
includes alphabetical listings of instance variables, events, and object
functions.

1



w_child

w_child

Description

Ancestry

Library

Usage

See also

12

Ancestor for all PFC child windows.

pfc_w_master

w_master
—Events
Activate pfc_MicroHelp pfc_PreUpdate
Close pfc_MRUClicked pfc_Print
CloseQuery pfc_MRUProcess pfc_Printimmediate
Move pfc_MRURestore >
Open pfc_MRUSave pfc_SaveAs
pfc_AcceptText pfc_New pfc_SaveObjects
pfc_BeginTran pfc_Open pfc_Update
pfc_Close pfc_PageSetup pfc_UpdateObjects
pfc_ControlGotFocus  pfc_PostOpen :_UpdatePrep
pfc_DBError pfc_PostUpdate pfc_UpdatesPending
pfc_Descendant pfc_PreClose pfc_UpdatesPendingRef
pfc_EndTran pfc_PreMRUSave pfc_Validation
pfc_Help pfc_PreOpen Resize
pfc_MessageRouter
- Object functions
Public of_AcceptText Public of_SetDBErrorMsg
Public of_GetCloseStatus Public of_SetLogicalUnitOfWork
Protected of_GetDWType Public of_SetPreference
Public of_Getinfo Public of_SetResize
Public of_ ted of_Setl
Protected of_GetUpdateObjects  Protected of_SetUpdateObjects
Protected of_| i ted of_
Protected of_IsUpdateable Public of_Update
Protected of_MessageBox Protected of_UpdateChecks
Public of_PostUpdate Public of_UpdatePrep
Protected of_SetAlwaysValidate Public of_UpdatesPending
Public of_SetBase Public of_Validation
pfc_w_child
. l w_child
~ No instance variables, events
or functions
PFCMAIN.PBL
PFEMAIN.PBL

Use this window as the ancestor for all of your application's child windows.

w_master
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w_frame

Description

Ancestry

Library

Object relationships

Usage

See also

Ancestor frame window for all MDI applications.

It includes MicroHelp automatically. To create a frame window without
MicroHelp, either modify or rename your application's frame window.

pfc_w_master

w_master

I~ Events

| Activate pfc_MicroHelp
Close pfc_MRUClicked
CloseQuery pfc_MRUProcess
Move pfc_MRURestore

{ Open pfc_MRUSave

| pfc_AcceptText pfc_New

| pfc_BeginTran pfc_Open

| pfc_Close pfc_PageSetup
pfc_ControlGotFocus  pfc_PostOpen
pfc_DBError pfc_PostUpdate
pfc_Descendant pfc_PreClose
pfc_EndTran pfc_PreMRUSave
pfc_Help pfc_PreOpen
pfc_MessageRouter

"~ Object functions
Public of_AcceptText Public
Public of_GetCloseStatus Public
Protected of_GetDWType Public
Public of_Getinfo Public

[

Public of_GetSaveStatus
Protected of_GetUpdateObjects

pfc_PreUpdate
pfc_Print
pfc_Printimmediate
pfc_Save
pfc_SaveAs
pfc_SaveObjects
pfc_Update
pfc_UpdateObjects
pfc_UpdatePrep
pfc_UpdatesPending
pfc_UpdatesPendingRef
pfc_Validation
Resize

of_SetDBErrorMsg
of_SetLogicalUnitOfwWork
of_SetPreference
of_SetResize

Protected of_SetUpdateable
Protected of_SetUpdateObjects
f.

Move (extend)
pfc_Cascade
pfc_Layer
pfc_MicroHelp (extend)
pfe_MinimizeAll

Object functions

tected y of

Protected of_lsUpdateable Public of_Update
Protected of_MessageBox Protected of_UpdateChecks
Public of_PostUpdate Public of_UpdatePrep
Protected of_SetAlwaysValidate Public of_UpdatesPending
Public of_SetBase Public of_Validation

pfc_PostOpen (extend)
pfc_PreToolbar
pfc_TileHorizontal
pfc_TileVertical
pfc_Toolbars
pfc_UndoArrange
Resize (extend)

Show

Public of_SetSheetManager

Public of_SetStatusBar

PFCMAIN.PBL
PFEMAIN.PBL

m_frame
n_cst_toolbarattrib
w_statusbar
w_toolbars

Use this window or a descendant as the frame window for all MDI applications

that use PFC.

m_frame
w_master
w_statusbar

13



w_frame

w_toolbars

Instance variables

W_frame includes instance variables:

Instance variable | Description Data type Access | Usage
inv_sheetmanager Reference variable for | n_cst_winsrv_sheetmanager Public Set with
sheet management of_SetSheetManager
service
inv_statusbar Reference variable for | n_cst_winsrv_statusbar Public Set with
status bar service of_SetStatusBar

Events

Activate

Description

Usage

Close

Description

14

W_frame includes precoded events:

Activate pfc_PostOpen
Close pfc_PreToolbar
Hide pfc_TileHorizontal
Move pfc_TileVertical
pfc_Cascade pfc_Toolbars
pfc_Layer pfc_UndoArrange
pfc_MicroHelp Resize
pfc_MinimizeAll Show

Calls the n_cst_appmanager of_SetFrame function to establish this window as

the active frame.

This event extends the ancestor Activate event.

This event executes when the window becomes active.

Destroys any instantiated services.
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Usage

Hide
Description

Usage

Move

Description

Usage

pfc_Cascade

Description
Return value

Usage

pfc_Layer
Description
Return value

Usage

pfc_MicroHelp

Description

Syntax

This event executes when the window closes.

Calls the n_cst_winsrv_statusbar pfc_Hide event.

This event executes when the window is hidden.

Positions the status bar when the user moves the window.

This event extends the ancestor Move event.

This event executes when the user moves the frame window.

Calls the n_cst_winsrv_sheetmanager pfc_Cascade event.
Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event executes when the user selects Window>Cascade from the menu bar
of a menu descended from the PFC m_master menu.

Calls the n_cst_winsrv_sheetmanager pfc_Layer event.
Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event executes when the user selects Window>Layer from the menu bar
of a menu descended from the PFC m_master menu.

Displays the passed string in the status bar.

This event extends the w_master pfc_MicroHelp event.

instancename.EVENT pfc_MicroHelp ( microhelp )

15



w_frame

Return value

Usage

pfc_MinimizeAll
Description
Return value

Usage

pfc_PostOpen

Description

Usage

pfc_PreToolbar
Description

Syntax

Usage

16

Argument Description

instancename Instance name of w_frame

microhelp String to be displayed in the status bar
None

This event is called by u_dw ItemFocusChanged event. It is also extended in
w_sheet.

Minimizes all open sheets.
Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event executes when the user selects Window>Minimize All from the
menu bar of a menu descended from the PFC m_master menu.

Opens the w_statusbar window if this capability has been requested through
the of_SetStatusBar function.

This event extends the w_master pfc_PostOpen event.

This event executes after the window opens.

Populates toolbar attributes.

instancename.EVENT pfc_PreToolbar ( attributes )

Argument Description

instancename Instance name of w_frame

attributes N_cst_toolbarattrib variable into which the event places toolbar
attributes (passed by reference)

The pfc_Toolbars event calls this event before displaying the w_toolbars
dialog box.
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pfc_TileHorizontal
Description
Return value

Usage

pfc_TileVertical

Description
Return value

Usage

pfc_Toolbars

Description

Return value

Usage

pfc_UndoArrange

Description

Return value

Usage

Resize

Description

Tiles sheets horizontally.
Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event executes when the user selects Window >Tile Horizontal from the
menu bar of a menu descended from the PFC m_master menu.

Tiles open sheets vertically.
Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event executes when the user selects Window>Tile Vertical from the
menu bar of a menu descended from the PFC m_master menu.

Displays the w_toolbars dialog box.

Integer. Returns 1 if the event succeeds, 0 if the user cancels out of the
w_toolbars dialog box, and -1 if an error occurs.

This event executes when the user selects View>Toolbars from the menu bar
of a menu that descends from the PFC m_master menu.

Calls the n_cst_winsrv_sheetmanager pfc_UndoArrange event.

Integer. Returns the number of sheets undone if the event succeeds and -1 if an
eITor Occurs.

This event executes when the user selects Window>Undo Arrange from the
menu bar of a menu descended from the PFC m_master menu.

Positions the status bar when the user resizes the window.
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Usage

Show
Description

Usage

Functions

This event executes when the user resizes the frame window.

Calls the n_cst_winsrv_statusbar pfc_Show event.

This event executes when the window displays after being hidden.

W_frame includes precoded object functions:

of_SetSheetManager
of_SetStatusBar

of_SetSheetManager

Description

Access

Syntax

Return value

Examples

of_SetStatusBar

Description

18

Creates or destroys an instance of n_cst_winsrv_sheetmanager, which
provides sheet management services.

Public

windowname.of_SetSheetManager ( boolean )

Argument Description

windowname Instance name of w_frame

boolean Boolean specifying whether to create (TRUE) or destroy
(FALSE) an instance of the n_cst_winsrv_sheetmanager object

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

This example calls the of_SetSheetManager function:

of_SetSheetManager (TRUE)
of_SetStatusBar (TRUE)

Creates or destroys an instance of n_cst_winsrv_statusbar, which provides
status bar services and opens the w_statusbar at the bottom of the frame.
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Access

Syntax

Return value

Usage

Examples

Public

windowname.of_SetStatusBar ( boolean )

Argument Description

windowname | Instance name of w_frame

boolean Boolean specifying whether to create (TRUE) or destroy
(FALSE) an instance of the n_cst_winsrv_statusbar object

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

On UNIX
The status bar service is not available on UNIX.

This example calls the of_SetStatusBar function:

of_SetStatusBar (TRUE)

19
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W_malin
Description

Ancestry

Library
Usage

See also

20

Ancestor main window for all SDI applications.

pfc_w_master

w_master
Events
Activate pfc_MicroHelp pfc_PreUpdate
Close pfc_MRUClicked pfc_Print
CloseQuery pfc_MRUProcess pfc_Printimmediate
Move pfc_MRURestore pfc_Save
Open pfc_MRUSave pfc_SaveAs
pfc_AcceptText pfc_New pfc_SaveObjects
pfc_BeginTran pfc_Open pfc_Update
fc_Close pfc_PageSetup pfc_UpdateObjects
pfc_ControlGotFocus pfc_PostOpen pfc_UpdatePrep
pfc_DBError pfc_PostUUpdate pfc_UpdatesPending
pfc_Descendant pfc_PreClose pfc_UpdatesPendingRef
pfc_EndTran pfc_PreMRUSave pfc_Validation
pfc_Help pfc_PreOpen Resize
pfc_MessageRouter
" Object functions
Public of_AcceptText Public of_SetDBErrorMsg
Public of_GetCloseStatus Public of_SetLogicalUnitOfWork
Protected of_GetDWType Public of_SetPreference
Public of_Getinfo Public of_SetResize
Public of_( Protected of_Setl
Protected of_GetUpdateObjects Protected of_SetUpdateObjects
Protected of_| y T of_¢
Protected of_lsUpdateable Public of_Update
ted of | of_UpdateChecks
Public of_PostUpdate Public of_UpdatePrep
Protected of_SetAlwaysValidate Public of_UpdatesPending
Public of_SetBase Public of_Validation
pfc_w_main
L w_main
No instance variables, events
or functions
Use w_main as the ancestor window for all single document interface (SDI)
applications.
w_master
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w_master

Description

Ancestry

Library

Object relationships

Usage

Descendants

W _master is the ancestor for all PFC windows. It includes instance variables,
events, and functions that are accessed by many PFC objects.

W_master is a self-updating object.

pfc_w_master

w_master
Events

| Activate pfc_MicroHelp pfc_PreUpdate

| Close pfc_MRUClicked pfe_Print

| CloseQuery pfc_MRUProcess pfc_Printimmediate

| Move pfc_MRURestore pfc_Save
Open pfc_MRUSave pfc_SaveAs
pfc_AcceptText pfc_New pfc_SaveObjects
pfc_BeginTran pfc_Open pfc_Update
pfc_Close pfc_PageSetup pfc_UpdateObjects
pfc_ControlGotFocus pfc_PostOpen pfc_UpdatePrep
pfc_DBError pfc_PostUpdate pfc_UpdatesPending
pfc_Descendant pfc_PreClose pfc_UpdatesPendingRef

| pfc_EndTran pfc_PreMRUSave pfc_Validation

‘ pfc_Help pfc_PreOpen Resize

| pfc_MessageRouter

'~ Object functions
Public of_AcceptText Public of_SetDBErrorMsg
Public of_GetCloseStatus Public of_SetLogicalUnitOfWork
Protected of_GetDWType Public of_SetPreference
Public of_Getinfo Public of_SetResize

Public of_( of_Setl

Protected of_GetUpdateObjects Protected of_SetUpdateObjects
Protected of_lsAlwaysValidate Protected of_SetupdateRequestor
Protected of_IsUpdateable Public of_Update
Protected of_| F of_UpdateChecks
Public of_PostUpdate Public of_UpdatePrep
Protected of_SetAlwaysValidate Public of_UpdatesPending
Public of_SetBase Public of_Validation

PFCWNSRV.PBL
PFEWNSRV.PBL

n_cst_appmanager
n_cst_dberrorattrib
n_cst_dwsrv_linkage
n_cst_luw

n_cst_winsrv
n_cst_winsrv_preference
n_cst_resize

u_dw

When writing a PFC-based application, all windows must descend from
w_master.

W_master is the ancestor of all PFC windows. When you add instance

variables, events, and functions to w_master, they are immediately available in
all PFC windows.

w_child
w_frame
w_main
Ww_popup

21
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See also

w_response
w_sheet

n_cst_appmanager
n_cst_winsrv
n_cst_winsrv_preference
n_cst_resize

Instance variables

W_master includes instance variables:

Instance variable Description Data type Access Usage
CONTINUE_ACTION | Constant set to 1 Integer Public Internal
FAILURE Constant set to -1 Integer Public Internal
ia_helptypeid Controls whether PFC calls | Any Protected | Set programmatically
the ShowHelp function by
topic, keyword, or index
ib_alwaysvalidate Controls whether the save Boolean Protected | Set with
process includes all objects of_SetAlwaysValidate
in the validation process (default is FALSE)
ib_closestatus Indicates whether the Boolean Protected | Internal.
window is closing
ib_disableclosequery Indicates whether Boolean Protected | Internal
CloseQuery processing is
enabled
ib_isupdateable Indicates whether the Boolean Protected | Set with
window can be updated of_SetUpdateable
(default is TRUE)
ib_savestatus Controls whether message Boolean Protected | Internal
display during the save
process
idw_active Current DataWindow U_dw Protected | Internal
inv_base Reference variable for n_cst_winsrv Public Set with of_SetBase
basic window services
inv_dberrorattrib Contains database error n_cst_ Protected | Set with
information dberrorattrib of_SetDBErrorMsg

22
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Instance variable Description Data type Access Usage
inv_luw Reference variable for n_cst_luw Protected | Set with of _
logical unit of work service SetLogicalUnitOfWork
inv_preference Reference variable for n_cst_winsrv_ | Public Set with
window preference service | preference of_SetPreference
inv_resize Reference variable for n_cst_resize Public Set with of_SetResize
resize service
ipo_pendingupdates[ ] | Default list of objects to be | PowerObject Protected | Internal
updated
ipo_updateobjects| ] Customized list of objects PowerObject Protected | Internal
to be updated
ipo_ One-time list of objects to PowerObject Protected | Internal
tempupdateobjects| ] be updated
ipo_updaterequestor Owner of the save process PowerObject Protected | Internal
NO_ACTION Constant set to 0 Integer Public Internal
PREVENT_ACTION | Constant set to 0 Integer Public Internal
SUCCESS Constant set to 1 Integer Public Internal
Events
W_master includes precoded events:
Activate pfc_Open
Close pfc_PageSetup
CloseQuery pfc_PostOpen
Move pfc_PostUpdate
Open pfc_PreClose

pfc_AcceptText

pfc_PreMRUSave

pfc_BeginTran pfc_PreOpen
pfc_Close pfc_PreUpdate
pfc_ControlGotFocus pfc_Print
pfc_DBError pfc_Printimmediate
pfc_Descendant pfc_Save
pfc_EndTran pfc_SaveAs

pfc_Help

pfc_SaveObjects

pfc_MessageRouter

pfc_Update

pfc_MicroHelp

pfc_UpdateObjects
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Activate

Description

Usage

Close

Description

Usage

CloseQuery

Description

Usage

Move
Description

Usage

24

pfc_MRUClicked pfc_UpdatePrep
pfc_MRUProcess pfc_UpdatesPending
pfc_MRURestore pfc_UpdatesPendingRef
pfc_MRUSave pfc_Validation
pfc_New Resize

Calls the n_cst_mru pfc_MRURestore event to restore changed menu items as
needed.

This event executes when the window becomes active.

Stores preference information and destroys any existing window service
objects.

This event executes when a window closes.

Accesses all DataWindows, checks for validation errors and, if changes are
pending, prompts the user to save the changes.

This event executes when a window closes, just before the Close event. It calls
one or more of the following:

¢ Pfc_PreClose
¢ Of_UpdateChecks
¢ Pfc_Save

Stores the window position and size.

This event executes when the user moves a window.
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Open

Description

Usage

pfc_AcceptText

Description

Syntax

Return value

Usage

pfc_BeginTran
Description
Return value

Usage

pfc_Close
Description

Usage

Triggers the pfc_PreOpen event and posts the pfc_PostOpen event. If the
preference and MRU services are enabled, this event also restores window
settings and MRU information.

This event executes when the window opens. It's best to add application-
specific code to either the pfc_PreOpen or pfc_PostOpen events.

Calls the n_cst_luw of_AcceptText function, which in turn calls the
of_AcceptText function for all controls that implement it.
instancename.EVENT pfc_AcceptText ( controlarray, focusonerror)

Argument Description

instancename | Instance name of the w_master-based descendant

controlarray | PowerObject array containing the controls for which to accept
text. From within the pfc_AcceptText event, access this value
through the apo_control argument

focusonerror | Boolean specifying whether to set focus on a DataWindow

column with errors. From within the pfc_AcceptText event,
access this value through the ab_focusonerror argument

Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event is called by the of_UpdateChecks function.

Empty user event that you extend to perform start-of-transaction processing.
Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event is called by the pfc_Save event.

Closes the window.

Call this event to close a window.

25



w_master

pfc_ControlGotFocus

Description Triggered when a PFC visual control gets focus. This event keeps track of the
current control.

Syntax instancename.EVENT pfc_ControlGotFocus ( control)

Argument Description

instancename | Instance name of the w_master-based descendant

control DragObject variable containing the control that just received
focus
Usage This event is called by PFC visual controls when they get focus.

Use this event to add application-specific functionality to be performed when
a visual control gets focus.

If the control getting focus is a DataWindow inherited from u_dw, this event
sets the idw_active instance variable.

pfc_DBError
Description Displays a database error encountered during the pfc_Save process.

Usage This event is called by pfc_Save if an update error occurs.

pfc_Descendant

Description PFC events and functions call this event to determine if the window is inherited
from w_master.

Return value Boolean. Always returns TRUE.

Usage Internal.

pfc_EndTran

Description Empty user event that you extend to initiate end-of-transaction processing,
such as COMMIT or ROLLBACK.

Syntax instancename.EVENT pfc_EndTran ( savecode )
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Return value

Usage

Examples

pfc_Help

Description

Return value

Usage

Argument Description

instancename | Instance name of the w_master-based descendant

savecode Integer specifying the return code from the pfc_Update function.
From within the pfc_EndTran event, access this value through
the ai_update_results argument

Integer. Return 1 if the end transaction process succeeds and other application-
specific values as appropriate.

This event is called by pfc_Save. The value passed in savecode indicates
whether previous updates succeeded or failed. Based on savecode, you extend
this event to add COMMIT, ROLLBACK, or other end-of-transaction
processing.

This example extends the pfc_EndTran event to COMMIT all open
transactions. This example returns Qif it succeeds and -1 if a COMMIT fails:

n_tr 1ltr_trans[ ]
Integer 1li_trans, 1li_count
Long 1l_return

li_trans = &

gnv_app.inv_trregistration.of_GetRegistered &
(ltr_trans)

IF 1li_trans = 0 THEN Return 0

For li_count = 1 to li_trans
11_return = ltr_trans[li_count].of_Commit ()
IF 11_return < 0 THEN Return -1

Next

Return 4

Calls the ShowHelp function by index, topic or keyword, based on the
ia_helptypeid instance variable.

Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event is triggered when the window has focus and the user selects
Help>Help Topics from the menu bar of a menu that descends from the PFC
m_master menu. You can also trigger it directly (from a Help
CommandButton, for example).
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Call the n_cst_appmanager of_SetHelpfile function to specify the application's
Help filename.

pfc_MessageRouter

Description Triggers the passed user event. This event first attempts to trigger the passed
user event on the window, then the current control. If the user event is not
found, it then attempts to trigger the passed user event on the last active
DataWindow control.

Syntax instancename.EVENT pfc_MessageRouter ( userevent)

Argument Description

instancename | Instance name of the w_master-based descendant

userevent String specifying the event to trigger. From within the
pfc_MessageRouter event, access this value through the
as_message argument

Return value Integer. Returns 1 if the event succeeds, O if no objects contain the user event,
and -1 if an error occurs.

Usage This event is triggered when the user selects a menu choice that calls the
of_SendMessage menu function.

All PFC visual controls, including u_dw, include events that work with the
message router.

pfc_MicroHelp

Description Ancestor event to which descendants add code that displays MicroHelp.
Syntax instancename.Eventpfc_MicroHelp ( microhelp )
Argument Description

instancename | Instance name of the w_master-based descendant

microhelp String to be displayed in the status bar

Usage This event is called by u_dw ItemFocusChanged event. It is extended in
w_frame and w_sheet.
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pfc_MRUCiicked

Description

Return value

Usage

pfc_MRUProcess

Description

Syntax

Return value

Usage

Examples

Checks for the existence of the specified menu item in the MRU DataStore and
calls the pfc_MRUProcess event if the menu item is found.

Integer. Returns 1 if the event succeeds and -1 if an error occurs.

Internal.

Empty user event that you extend to open the appropriate window based on the
clicked MRU menu item.

instancename.EVENT pfc_MRUProcess ( row)
Argument Description

instancename | Instance name of the w_master-based descendant

row Integer specifying the MRU DataStore row that corresponds to
the clicked MRU menu item. From within the pfc_MRUProcess
event, access this value through the ai_row argument

Integer. Returns 1 if the event succeeds and -1 if an error occurs.

You extend this event to open windows (SDI) or sheets (MDI) with or without
passing parameters.

The pfc_w_master ancestor contains sample code for this event.

This example shows code you might add to the pfc_ MRUProcess event:

window 1lw_frame, lw_window
n_cst_menu 1lnv_menu
n_cst_mruattrib lnv_mruattrib

// check parameters
if isnull(ai_row) then
return -1
end if
if not isvalid(gnv_app.inv_mru) then
return -1
end if
// retrieve row from datastore and do work with it
gnv_app.inv_mru.of_getmruitem(ai_row, lnv_mruattrib)
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pfc_MRURestore
Description

Usage

pfc_MRUSave
Description
Return value

Usage

pfc_New

Description

Usage

30

// get the mdi frame if necessary

1nv_menu.of_getmdiframe (this.menuid, 1lw_frame)

//example opens

// SDI Process

//open (lw_window, lnv_mruattrib.is_classname)

/ /openwithparm(lw_window, &

// Inv_mruattrib.is_menuitemkey, &

// lnv_mruattrib.is_classname)

// MDI Process

/ /opensheet (lw_window, lnv_mruattrib.is_classname, &

// lw_frame)

/ /opensheet (lw_window, lnv_mruattrib.is_classname, &

// 1lw_frame, 0, original!)

Return opensheetwithparm(lw_window, &
Inv_mruattrib.is_menuitemkey, &

lnv_mruattrib.is_classname, 1lw_frame, 0, &
original! )

Restores MRU settings.

The Open event calls this event.

Saves MRU key information.
Integer. Returns 1 if the event succeeds and -1 if an error occurs.

This event is called by the Close event.

Empty user event into which you place code that performs processing to add a
new entity to the current window, window control, or DataWindow.

Use this event for application- and window-specific new entity processing.

This event is triggered when the user selects File>New from the menu bar of a
menu that descends from the PFC m_master menu.
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Examples

pfc_Open

Description

Usage

Examples

pfc_PageSetup

Description

Return value

This exampie, which might be found in a descendent sheet or main window,
inserts a new row into the active DataWindow when the user selects File>New
from the menu bar:

idw_active.InsertRow(0)

Empty user event into which you place code that performs processing to open
a new entity (typically a file) in the current window, window control, or
DataWindow.

Use this event for application- and window-specific open processing.

This event is triggered when the user selects File>Open from the menu bar of
a menu that descends from the PFC m_master menu.

This example, which might be found in a descendent sheet or main window,
displays the Open dialog box when the user selects File>Open from the menu
bar. Is_fullname and is_filename are instance variables:

Integer 1li_fileid

SetPointer (HourGlass!)
IF GetFileOpenName &
("Open", is_fullname, is_filename &
"txt", "Text Files (*.txt),*.txt) < 1 THEN
Return
END IF

// Open the new file and put results into the MLE.
li_fileid = FileOpen(is_fullname, StreamMode!)
FileRead (li_fileid, mle_notepad.text)

FileClose (li_fileid)

Empty user allowing you to add code to display a Page Setup dialog box and
print multiple DataWindows.

Integer. Returns 1 if the event succeeds and -1 if an error occurs.
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Usage

Examples

pfc_PostOpen

Description

Usage

Examples

pfc_PostUpdate

Description

Syntax

32

Call this event to synch page setup properties among multiple DataWindows.

This example synchs the paper source for three DataWindows:

Integer 1li_rc
s_pagesetupattrib 1lstr_pagesetup

li_rc = dw_l.event pfc_PageSetupDlg (lstr_pagesetup)
IF li_rc = 1 THEN
dw_2.object.datawindow.print.paper.source
lstr_pagesetup.i_papersource
dw_3.object.datawindow.print.paper.source = &
lstr_pagesetup.i_papersource
END IF

&

Empty user event into which you place code that performs processing just after
a window opens.

Use this event for application- and window-specific post-open processing. This
event executes just after a window opens.

This example calls the Retrieve function in a window's pfc_PostOpen event:

Long 1ll_return

11_return = dw_employee.EVENT pfc_Retrieve()

IF 11_return = -1 THEN
MessageBox ("Retrieve", "Retrieval error")
ELSE
gnv_app.of_getframe() .SetMicroHelp &
(String(ll_return) + " rows retrieved")
END IF

Calls the n_cst_luw of_PostUpdate function, which in turn calls the
of_PostUpdate function for all controls that implement it.

instancename.EVENT pfc_PostUpdate ( controlarray )
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Return value

Usage

pfc_PreClose

Description

Return value

Usage

Examples

pfc_PreMRUSave

Description

Syntax

Argument Description

instancename | Instance name of the w_master-based descendant

controlarray | PowerObject array containing the controls for which to perform
post update processing. From within the pfc_AcceptText event,
access this value through the apo_control argument

Integer. Returns 1 if the event succeeds and -1 if an error occurs.

The pfc_Save user event calls this event after calling the pfc_DBError user
event.

You can extend this event to perform additional post-update processing.

Empty user event that you extend to perform processing just before a window
closes.

Integer. Return 1 if the pre-close process succeeds and -1 to prevent the
window from closing.

Use this event for application- and window-specific pre-close processing.

This event executes just before CloseQuery processing.

This example uses the pfc_PreClose function to write to a log file:

IF inv_filesrv.of_FileWrite &

(is_logfile, "Window: " + this.title &
+ " closing at " + String(Today()) &
+ String (Now()),TRUE) = 1 THEN
Return 1
ELSE
Return -1
END IF

Empty user event that you extend to create a key that you can later access when
opening windows.

instancename.EVENT pfc_PreMRUSave ( mruattrib )
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Argument Description
instancename Instance name of the w_master-based descendant
mruattrib N_cst_mruattrib into which the event places window
information
Return value Integer. Returns 1 if the event succeeds and -1 if an error occurs.
Usage You must populate all three values in the n_cst_mruattrib structure object.
Examples This example shows code you might add to the pfc_PreMRUSave event:
anv_mruattrib.is_classname = this.classname()
anv_mruattrib.is_menuitemname = this.title
anv_mruattrib.is_menuitemkey = this.classname()
pfc_PreOpen
Description Empty user event into which you place code that performs processing just

before a window opens.

Usage Use this event for application- and window-specific pre-open processing.

This event executes just before a window opens.

Examples This example connects to the database in the frame window's pfc_PreOpen
event:

String 1ls_file, 1ls_section
Long 1ll_return

1ls_file = "c:\pbapp\pbapp.ini"
1ls_section = "PBAppDB"

itr_pbapp.of_Init(ls_file, ls_section)

11_return = itr_pbapp.of_Connect()

IF 1l_return <> 0 THEN
itr_pbapp.of_Rollback()

MessageBox ("PBApp", "Connect error")
END IF
pfc_PreUpdate
Description Empty user event into which you place pre-save processing.
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Return value

Usage

Examples

pfc_Print

Description

Usage

Examples

Integer. Return 1 if the pre-save processing succeeds and -1 if it does not.

Extend this event to perform application-specific pre-save processing.

The pfc_Save user event calls this event before performing any save
processing. If you return -1, save processing terminates.

This example adds code to the pfc_PreUpdate event to check for user ID:

String 1ls_user

ls_user = gnv_app.of_GetUserID()
IF ls_user = "RNielsen" THEN
Return -1
ELSE
Return 1
END IF

Empty user event into which you place code that prints windows or
DataWindows, first displaying the Print dialog box.

Extend this event to print application- and window-specific information. For
example, you might print a single DataWindow. Alternatively, you might call
the DataWindow report service's of_CreateComposite function to create a
composite report of all the window's DataWindows.

This event is triggered when the user selects File>Print from the menu bar of a
menu that descends from the PFC m_master menu.

This example synchs the copies property of all DataWindows on the window:
Integer 1li_rc

s_printdlgattrib 1lstr_printdlg

li_rc = dw_1.Event pfc_PrintDlg(lstr_printdlg)
IF li_rc = 1 THEN

dw_2.object.datawindow.print.copies = &
lstr_printdlg.l_copies
dw_3.object.datawindow.print.copies = &

lstr_printdlg.l_copies
END IF
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pfc_Printimmediate
Description

Usage

Examples

pfc_Save

Description

Return value

Usage

36

Empty user event into which you place code that prints windows or
DataWindows without displaying the Print dialog box.

Extend this event to print application- and window-specific information.

This event is triggered when the user selects File>Print Inmediate from the
menu bar of a menu that descends from the PFC m_master menu.

This example prints the dw_employee DataWindow:

IF dw_employee.Event pfc_PrintImmediate( ) <> 1 THEN
Return -1
END IF

Calls w_master user events and functions to save changes for all self-updating
objects in the window.

Integer. Returns values as follows:

¢ 1 Allsave processes succeeded
¢ 0 No pending updates

¢ -1 Accept text error

-2 Updates pending error

-3 Validation error

-4 Pre-update process failed

-5 Pfc_BeginTran failed
Pfc_Update failed

-7 Pfc_EndTran failed

-8 Post-update process failed

*® & & o o o * *
]
»

-9 Update prep process failed

The CloseQuery event calls this user event automatically to check for pending
updates and initiate the save process. You can call it from your application to
save changes, as needed.

FOR INFO For more on the save process, see n_cst_luw on page 1139.
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pfc_SaveAs

Description Empty user event allowing you to save all or part of a window.

Usage This event is triggered when the user selects File>Save As from the menu bar
of a menu that descends from the PFC m_master menu.

Examples This example displays the Save As dialog box:

String is_docname, is_named
Integer 1li_value

1li_value = GetFileSaveName("Save As", &
is_docname, is_named, "TXT", &
"Text Files (*.TXT),*.TXT," + &
" Doc Files (*.DOC), *.DOC")

pfc_SaveObjects
Description Performs a save on the specified controls.

Syntax instancename.EVENT pfc_SaveObjects ( controlarray )
Argument Description

instancename | Instance name of the w_master-based descendant

controlarray | PowerObject array containing the controls for which to perform
save processing. From within the pfc_SaveObjects event, access
this value through the apo_control argument

Return value Integer. Returns values as follows:
¢ 1 All save processes succeeded
¢ 0 No pending updates
¢ -1 Accept text error

-2 Updates pending error

-3 Validation error

-4 Pre-update process failed

-5 Pfc_BeginTran failed

-6 Pfc_Update failed

* & & o o
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¢ -7 Pfc_EndTran failed
¢ -8 Post-update process failed

¢ -9 Update prep process failed

Usage Call the of_SetUpdateObjects function to establish the array of controls to be
updated.
Examples This example calls the pfc_SaveObjects event:

PowerObject 1po_savel ]
Integer 1li_return

lpo_save[l] = dw_1
this.of_SetUpdateObjects (lpo_save)
1li_return = this.EVENT pfc_SaveObjects (lpo_save)

pfc_Update
Description Calls the pfc_UpdateObjects event.
Syntax instancename.EVENT pfc_Update ( controlarray )
Argument Description
instancename Instance name of the w_master-based descendant
controlarray PowerObject array containing the controls to be updated. From
within the pfc_Update event, access this value through the
apo_control argument
Return value Integer. Returns 1 if the event succeeds and -1 if one or more DataWindow
update errors occur.
Usage The pfc_Save event calls this event.

pfc_UpdateObjects

Description Calls the n_cst_luw of_Update function, which in turn calls the of_Update
function for all controls that implement it.

Syntax instancename.EVENT pfc_UpdateObijects ( controls, accepttext, resetflags )
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Return value

Usage

pfc_UpdatePrep
Description

Syntax

Return value

Usage

Argument Description

instancename | Instance name of the w_master-based descendant

controls PowerObject array containing the objects to update. This
argument is accessed through the apo_control argument

accepttext Boolean specifying whether n_cst_luw should automatically
perform an AcceptText before performing the Update (TRUE) or
not (FALSE)

resetflags Boolean specifying whether n_cst_luw should automatically

reset DataWindow update flags (TRUE) or not (FALSE)

Integer. Returns 1 if the event succeeds, 0 if no action was taken, and -1 if one
or more update errors occur.

The of_Update function and the pfc_Update event call this event.

Empty user event to which you can add code that prepares for update.

instancename.EVENT pfc_UpdatePrep ( controls )
Argument Description

instancename | Instance name of the w_master-based descendant

controls PowerObject array containing the objects to update. This
argument is accessed through the apo_control argument

Long. Return 1 if the update preparation succeeds and -1 to halt the update
process.

The of_UpdatePrep function calls this event.

pfc_UpdatesPending

Description

Syntax

Calls the pfc_UpdatesPendingRef event.

When CloseQuery calls this user event, validation messages are suppressed.

instancename.EVENT pfc_UpdatesPending ( controlarray )
Argument | Description

instancename l Instance name of the w_master-based descendant
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Return value

Usage

Argument | Description

controlarray PowerObject array containing controls to be tested for
pending updates
Integer. Returns values as follows:
¢ 1 Pending updates were found
¢ 0 No pending updates
¢ -1 AcceptText failed

The CloseQuery event calls this event to determine if there are pending
updates.

pfc_UpdatesPendingRef

Description

Syntax

Return value

Usage

40

Calls the n_cst_luw of_UpdatesPending function, which in turn calls the
of_UpdatesPending function for all controls that implement it.

instancename.Eventpfc_UpdatesPendingRef ( controls, pending)

Argument Description
instancename Instance name of the w_master-based descendant
controls PowerObject array containing the objects to update. This

argument is accessed through the apo_control argument

pending PowerObject array to contain objects with pending updates.
This argument is accessed through the apo_pending argument
(passed by reference)

Integer. Returns values, as follows:
¢ 1 Pending updates were found
¢ 0 No pending updates

¢ -1 AcceptText failed

The pfc_UpdatesPending event calls this event to determine if there are
pending updates.
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pfc_Validation

Description

Syntax

Return value

Usage

Resize
Description

Usage

Functions

Calls the n_cst_luw of_Validation function, which in turn calls the
of_Validation function for all controls that implement it.

instancename . EVENT pfc_Validation ( controlarray )

Argument Description
instancename Instance name of the w_master-based descendant
controlarray PowerObject control array containing controls to be validate

Integer. Returns 1 if there are no validation errors and -1 if a validation error

occurs.

The of_Validation and of_UpdateChecks functions call this event to determine

if there are validation errors.

Triggers automatic resize processing, if enabled in n_cst_resize.

This event executes when the user resizes the window.

W_master includes precoded object functions:

of_AcceptText

of_SetDBErrorMsg

of_GetCloseStatus

of_SetLogicalUnitOfWork

of_GetDWType

of_SetPreference

of_Getlnfo

of_SetResize

of_GetSaveStatus

of_SetUpdateable

of_GetUpdateObjects

of_SetUpdateObjects

of_IsAlwaysValidate

of_SetUpdateRequestor

of_IsUpdateable

of_Update

of_MessageBox

of_UpdateChecks

of_PostUpdate

of_UpdatePrep

of_SetAlwaysValidate

of_UpdatesPending

of_SetBase

of_Validation

11
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of_AcceptText
Description
Access

Syntax

Return value

Usage

Examples

of_GetCloseStatus
Description
Access

Syntax

Return value

Usage

42

Calls the pfc_AcceptText event.
Public

instancename.of_AcceptText ( focusonerror)

Argument Description

instancename Instance name of w_master

focusonerror Boolean indicating whether PFC sets focus to the first item in
error when an error occurs

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

N_cst_luw calls this function as part of the default save process. This function
is part of the self-updating object API. To customize accept text processing,
extend the pfc_AcceptText event.

This example is from the n_cst_luw of_AcceptText function:

If 1b_defined Then
li_rc = &
lpo_tocheck.Function Dynamic of_AcceptText &
(ab_focusonerror)
If 1i_rc < 0 Then Return -1

Reports the window's close status (whether the window is closing.)
Public

windowname.of_GetCloseStatus ()

Argument | Description

windowname ‘ Instance name of w_master

Boolean. Returns TRUE if the window is closing and FALSE if it is not.

PFC does not report validation errors if the window is closing.
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Examples This example calls the of_GetCloseStatus function:

IF al_row <> 0 AND &
(Not lw_parent. of_GetCloseStatus ( )) THEN
IF IsValid(gnv_app) THEN
MessageBox (gnv_app.iapp_object.Appname, &
"Required Value Missing for " &
+ as_colname + " on row " + &
String(al_row) + &
'. Please enter a value.', StopSign!)
ELSE

of_GetDWType

Description Indicates whether a DataWindow is a descendant of u_dw and whether it uses
the linkage service.

Access Protected
Syntax instancename.of_GetDWType ( datawindow )

Argument Description

instancename Instance name of w_master

datawindow DataWindow variable containing the DataWindow to be tested
Return value Integer. Returns values as follows:

¢ 0 Datawindow is not a descendant of u_dw

¢ 1 Datawindow is a descendant of u_dw

¢ 2 Datawindow is a descendant of u_dw and it is linked
*

-1 An error occurred

Usage Internal.

Examples This example calls the of_GetDWType function:

1li_dwtype = of_GetDWType (ldw_dw)
If 1i_dwtype < 0 Then Return -1
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of_Getinfo
Description
Access

Syntax

Return value

Examples

of_GetSaveStatus

Description

Access

Syntax

Return value

Usage

Examples
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Retrieves object information.
Public

instancename.of_Getinfo ( infoobject)

Argument Description

instancename Instance name of w_master

infoobject N_cst_infoattrib instance into which the function places
information (passed by reference)

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

This example calls the of_GetInfo function:

n_cst_infoattrib 1lnv_info

w_emplist.of_GetInfo(lnv_info)

MessageBox ("Info", &
"Description: " + 1lnv_info.is_description &

+ ". Name: " + 1lnv_info.is_name)

Reports the window's save status (whether the window is in the process of

updating its DataWindows).
Public

windowname.of_GetSaveStatus ()

Argument | Description

windowname ) Instance name of w_master

Boolean. Returns TRUE if the window is updating and FALSE if it is not.

Call this function to determine whether a window is updating its
DataWindows.

This example calls the of_GetSaveStatus function:

IF lw_parent.TriggerEvent &



Chapter 2 Window Objects

("pfc_Descendant") = 1 THEN
1lb_pfcsaveprocess = &
lw_parent.of_GetSaveStatus ()
END IF

of_GetUpdateObjects

Description
Access

Syntax

Return value

Examples

of_IsAlwaysValidate

Description

Access

Retrieves the current default array of objects affected by the update process.
Protected

instancename.of_GetUpdateObjects ( objects )

Argument Description

instancename Instance name of w_master

objects PowerObject array into which the function places objects to
be updated (passed by reference)

Integer. Returns the number of elements in the objects array if the function
succeeds and -1 if an error occurs.

This example calls the of_GetUpdateObjects function:

PowerObject 1lpo_objs[ ]
Integer 1li_return, 1li_count

li_return = this.of_GetUpdateObjects (1po_objs)
FOR li_count = 1 to li_return
IF lpo_objs[li_count] = ids_data THEN
Return 1
END IF
NEXT
1li_return++
lpo_objs[li_return] = ids_data
Return this.of_SetUpdateObjects (lpo_objs)

Reports whether the default save process always performs validation.

Protected
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Syntax

Return value

Examples

of_IsUpdateable

Description

Access

Syntax

Return value
Usage

Examples

of_MessageBox
Description

Access

46

instancename.of_IsAlwaysValidate ()

Argument | Description

instancename { Instance name of w_master

Boolean. Returns TRUE if the default save process always performs validation
and FALSE if it does not.

This example calls the of_IsAlwaysValidate function:

IF this.of_IsAlwaysValidate() = TRUE THEN

MessageBox ("Window", "Always validate")
ELSE

MessageBox ("Window", "Sometimes validate")
END IF

Reports whether the window is updatable and should be included in save
processing.

Protected

instancename.of_lsUpdateable ()

Argument | Description

instancename . Instance name of w_master

Boolean. Returns TRUE if the window is updatable and FALSE if it is not.
Internal.

This example is from the pfc_UpdatesPendingRef event:

If Not of_IsUpdateable() Then Return NO_UPDATESPENDING

Displays a MessageBox.

Protected
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Syntax

Argument

instancename.of_MessageBox ( id, title, message, icon, button, default)

Description

instancename

Instance name of w_master

id

String specifying an ID for the message

title

String specifying the title of the MessageBox

message

String specifying the message text

icon

Icon enumerated data type indicating the icon you want to
display on the left side of the message box. Values are:

Information!
StopSign!

Exclamation!

* & & o

Question!
¢ None!

button

Button enumerated data type indicating the set of
CommandButtons you want to display at the bottom of the
message box. The buttons are numbered in the order listed in the
enumerated data type. Values are:

OK!

OKCancel!
YesNo!
YesNoCancel!
RetryCancel!
AbortRetryIgnore!

* & & ¢ o o

default

Return value

Usage

Integer specifying the number of the button you want to be the
default button

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

Override this function to control MessageBox behavior in windows.

The id argument is not used in the default implementation.

Examples

This example calls the of_MessageBox function:

of Messagebox('win_error', 'Save', &

as_error,

StopSign!, Ok!, 1)
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of_PostUpdate

Description Calls the pfc_PostUpdate event.
Access Public
Syntax instancename.of_PostUpdate ()
Argument | Description
instancename ‘ Instance name of w_master
Return value Integer. Returns 1 if the function succeeds and -1 if an error occurs.
Usage N_cst_luw calls this function as part of the default save process. This function

is part of the self-updating object API. To customize post-update processing,
extend the pfc_PostUpdate event.

Examples This example is from the n_cst_luw of_PostUpdate function:

If 1b_defined Then
li_rc = &
lpo_tocheck.Function Dynamic of_PostUpdate ()

of _SetAlwaysValidate

Description Specifies whether the default save process always performs validation.
Access Protected
Syntax instancename.of_SetAlwaysValidate ( boolean )
Argument Description
instancename Instance name of w_master
boolean Boolean specifying whether the default save process always
perform validation (TRUE) or only performs validation if a
control has pending updates (FALSE)

Return value Integer. Returns 1 if the function succeeds and -1 if an error occurs.

Examples This example calls the of_SetAlwaysValidate function:

this.of_SetAlwaysValidate (TRUE)
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of_SetBase
Description
Access

Syntax

Return value

Usage

Examples

of_SetDBErrorMsg

Description

Access

Syntax

Return value

Enables or disables n_cst_winsrv, which provides basic window services.
Public

instancename.of_SetBase ( boolean )

Argument Description

instancename Instance name of w_master

boolean Boolean specifying whether to enable (TRUE) or disable
(FALSE) an instance of the n_cst_winsrv object

Integer. Returns 1 if the function succeeds, O if the service is already enabled,
and -1 if an error occurs.

Use this function to create or destroy an instance of n_cst_winsrv. This
instance is named inv_base.

Because all window services are descendants of n_cst_winsrv (and have
n_cst_winsrv functions available to them), use this object when you require
basic window services only.

This example calls the of_SetBase function in a window Open event to enable
basic window services:

this.of_SetBase (TRUE)

Saves a database update error message for display after save processing
completes.

Public

windowname.of_SetDBErrorMsg ( message )

Argument Description
windowname Instance name of w_master
message String or n_cst_dberrorattrib containing the error message

Integer. Returns 1 if the function succeeds and -1 if an error occurs.
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Usage

Examples

Call this function to save a database error message for display after
ROLLBACK processing completes.

The u_dw DBError event populates this instance variable, suppressing the
display of a message dialog box. This allows you to roll back changes in the
pfc_EndTran event. After calling pfc_EndTran, the pfc_Save process displays
this message.

This example is from the u_dw DBError event:

If Isvalid(lpo_updaterequestor) Then
lpo_updaterequestor.Dynamic Function &
of_SetDBErrorMsg (lnv_dberrorattrib)
Else

of_SetLogicalUnitOfWork

Description
Access

Syntax

Return value

Usage

Examples

of_SetPreference

Description

50

Enables or disables n_cst_luw, which provides the logical unit of work service.
Public

instancename.of_SetLogicalUnitOfWork ( boolean )

Argument Description

instancename Instance name of w_master

boolean Boolean specifying whether to enable (TRUE) or disable
(FALSE) n_cst_luw

Integer. Returns 1 if the function succeeds, O if the service is already enabled,
and -1 if an error occurs.

Use this function to create or destroy an instance of n_cst_luw. This instance
is named inv_luw. If you do not enable n_cst_luw, w_master enables it
automatically.

This example calls the of_SetLogicalUnitOfWork function:

this.of_SetLogicalUnitOfWork (TRUE)

Enables or disables n_cst_winsrv_preference, the window preference service.
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Access

Syntax

Return value

Usage

Examples

of _SetResize
Description
Access

Syntax

Return value

Usage

Examples

Public

instancename.of_SetPreference ( boolean )

Argument Description

instancename | Instance name of w_master

boolean Boolean specifying whether to enable (TRUE) or disable
(FALSE) an instance of the n_cst_winsrv_preference object

Integer. Returns 1 if the function succeeds, 0 if the service is already enabled,
and -1 if an error occurs.

Use this function to create or destroy an instance of n_cst_winsrv_preference.
This instance is named inv_preference.

This example calls the of_SetPreference function:

this.of_SetPreference (TRUE)

Enables or disables n_cst_resize, the resize service.
Public

instancename.of_SetResize ( boolean )

Argument Description

instancename Instance name of w_master

boolean Boolean specifying whether to enable (TRUE) or disable
(FALSE) an instance of the n_cst_resize object

Integer. Returns 1 if the function succeeds, 0 if the service is already enabled,
and -1 if an error occurs.

Use this function to create or destroy an instance of n_cst_resize. This instance
is named inv_resize.

This example calls the of_SetResize function:

this.of_SetResize (TRUE)
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of_SetUpdateable

Description

Access

Syntax

Return value

Usage

Examples

Specifies whether the window is updatable and should be included in a default
save process.

Protected

instancename.of_SetUpdateable ( boolean )

Argument Description
instancename Instance name of w_master
boolean Boolean indicating whether the window is updatable

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

Call this function to disable default save processing for windows that are not
updatable.

This example calls the of_SetUpdateable function:

this.of_SetUpdateable (FALSE)

of_SetUpdateObjects

Description
Access

Syntax

Return value

Usage

Examples

52

Sets a new default array containing objects for which updates are attempted.
Protected

instancename.of_SetUpdateObjects ( requestor )

Argument Description
instancename Instance name of u_dw
requestor PowerObject array containing the object to be updated

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

Call this function to customize the objects updated by the save process. You
can even add other windows to the save process.

This example calls the of_SetUpdateObjects function:

PowerObject 1lpo_objs[ ]
Integer 1li_count

lpo_objs = this.control
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1li_count = UpperBound (lpo_objs)
1li_count++

// Update w_other as well as this window
lpo_objs[li_count] = w_other

Return this.of_SetUpdateObjects (lpo_objs)

of_SetUpdateRequestor

Description

Access

Syntax

Return value
Usage

Examples

of_Update
Description
Access

Syntax

Creates a reference to the object requesting an update within a logical unit of

work.
Protected

instancename.of_SetUpdateRequestor ( requestor)

Argument Description
instancename Instance name of w_master
requestor PowerObject containing the object requesting the update

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

Internal.

This example is from the of_SetLogicalUnitOfWork function:
inv_luw = create n_cst_luw

inv_luw.of_SetRequestor (this)
inv_luw.of_SetUpdateRequestor (this)

Calls the pfc_UpdateObjects event.
Public

instancename.of_Update ( accept, resetflag {, requestor} )

Argument Description

instancename Instance name of w_master

accept Boolean indicating whether the Update function performs an
AcceptText before saving rows to the database
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Argument Description
resetflag Boolean indicating whether the Update function resets the
update flags
requestor PowerObject containing the requestor object
(optional)
Return value Integer. Returns 1 if the update succeeds and -1 if an error occurs.
Usage N_cst_luw calls this function as part of the default save process. This function

is part of the self-updating object API. To customize update processing, extend
the pfc_Update event.

You typically call the pfc_Save event instead of this function.

Examples This example is from the n_cst_luw of_Update function:

If 1b_defined Then
li_rc = lpo_tocheck.Function Dynamic of_Update &
(ab_accepttext, ab_resetflag, &
1lpo_updaterequestor)
If 1li_rc < 0 Then Return -1

Continue
End If
of_UpdateChecks
Description Determines whether edits are pending and whether there are any validation
erTors.
Access Protected
Syntax instancename.of_UpdateChecks ( { controls } )
Argument Description
instancename Instance name of w_master
controls PowerObject array containing the objects to be checked
(optional)
Return value Integer. Returns values as follows:

¢ 1 Updates are pending and there are no validation errors
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Usage

Examples

of_UpdatePrep

Description

Access

Syntax

Return value

Usage

Examples

¢ 0 No updates pending

¢ -1 AcceptText error

¢ -2 UpdatesPending error

¢ -3 Validation error

Internal.

This example is from the pfc_Save event:

li_rc = of_UpdateChecks (lpo_updatearray)
If 1i_rc <= 0 Then

Calls the pfc_UpdatePrep event, which allows you to code additional update
preparation logic.

Public

instancename.of_UpdatePrep ()
Argument | Description

instancename | Instance name of w_master

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

N_cst_luw calls this function as part of the default save process. This function
is part of the self-updating object API. To customize update preparation
processing, extend the pfc_UpdatePrep event.

This example is from the n_cst_luw of_UpdatePrep function:

If 1b_defined Then
li_rc = &
lpo_tocheck.Function Dynamic of_UpdatePrep ()
If 1i_rc < 0 Then Return -1
Continue
End If
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of_UpdatesPending

Description
Access

Syntax

Return value

Usage

Examples

of _Validation
Description
Access

Syntax

Return value

Usage

56

Calls the pfc_UpdatesPendingRef event.
Public

instancename.of_UpdatesPending ()

Argument | Description

instancename ) Instance name of w_master

Integer. Returns values as follows:
¢ 1 Updates are pending
¢ 0 No updates pending

¢ -1 Anerror occurred

N_cst_luw calls this function as part of the default save process. This function
is part of the self-updating object API. To customize pending updates
processing, extend the pfc_UpdatesPending event.

This example calls the of_UpdatesPending function:

If 1b_defined Then
la_rc = lpo_tocheck.Dynamic of_UpdatesPending()

Calls the pfc_Validation event.
Public

instancename.of_Validation ()

Argument | Description

instancename Instance name of w_master

Integer. Returns 1 if the function succeeds and -1 if a validation error occurs.

N_cst_luw calls this function as part of the default save process. This function
is part of the self-updating object API. To customize validation processing,
extend the pfc_Validation event.
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Examples This example calls the of Validation function:

If 1b_defined Then
li_rec = &
lpo_tocheck.Function Dynamic of_Validation ()
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W_popup

Description Ancestor for all PowerBuilder Foundation Class Library popup windows.
Ancestry pfc_w_master
| w_master
"“Evenh
Activate pfc_MicroHelp pfc_PreUpdate
Close pfc_MRUClicked pfc_Print
CloseQuery pfc_MRUProcess pfc_Printimmediate
Move pfc_MRURestore pfc_Save
Open pfc_MRUSave pfc_SaveAs
pfc_AcceptText pfc_New pfc_SaveObijects
pfc_BeginTran :_Open pfc_Update
pfc_Close pfc_PageSetup pfc_UpdateObjects
pfc_ControlGotFocus pfc_PostOpen pfc_UpdatePrep
pfc_DBEmor pfc_PostUpdate pfc_UpdatesPending
pfc_Descendant pfc_PreClose pfc_UpdatesPendingRef
pfc_EndTran pfc_PreMRUSave pfc_Validation
pfc_Help pfc_PreOpen Resize
pfc_MessageRouter
"~ Object functions
Public of_AcceptText Public of_SetDBErrorMsg
Public of_GetCloseStatus Public of_SetLogicalUnitOfWork
Protected of_GetDWType Public of_SetPreference
Public of_Getinfo Public of_SetResize
Public of_GetSaveStatus Protected of_SetUpdateable
Protected of_GetUpdateObjects Protected of_SetUpdateObjects
Protected of_IsAlwaysValidate Protected of_SetupdateRequestor
Protected of_IsUpdateable Public of_Update
U of_| of_UpdateChecks
Public of_PostUpdate Public of_UpdatePrep
Protected of_SetAlwaysValidate Public of_UpdatesPending
Public of_SetBase Public of_Validation
pfc_w_popup
W_popup
No instance variables, events
or functions
Library PFCMAIN.PBL
PFEMAIN.PBL
Usage Use w_popup as the ancestor window for all popup windows.
See also w_master
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W_response

Description

Ancestry

Library

Usage

See also

Events

Ancestor for all PFC response windows.

pfc_w_master
w_master

~Events
Activate
Close
CloseQuery
Move
Open
pfc_AcceptText
pfc_BeginTran
pfc_Close
pfc_ControlGotFocus
pfc_DBError
pfc_Descendant
pfc_EndTran
pfc_Help
pfc_MessageRouter

" Object functions

Protected
Protected
Protected
Public

Protected of_GetUpdateObjects
of_IsAlwaysValidate
of_IsUpdateable
of_MessageBox
of_PostUpd:

pfc_MicroHelp
pfc_MRUClicked
pfc_MRUProcess
pfc_MRURestore
pfc_MRUSave
pfc_New
pfc_Open
pfc_PageSetup
pfc_PostOpen
pfc_PostUpdate
pfc_PreClose
pfc_PreMRUSave
pfc_PreOpen

Public

ate Public

pfc_PreUpdate
pfe_Print
pfc_Printimmediate

pfc_SaveAs
pfc_SaveObjects
pfc_Update
pfc_UpdateObjects
pfc_UpdatePrep
pfc_UpdatesPending
pfc_UpdatesPendingRef
pfc_Validation

Resize

Public of_AcceptText Public of_SetDBErrorMsg
Public of_GetCloseStatus Public of_SetLogicalUnitOfWork
Protected of_GetDWType Public of_SetPreference

Public of_Getinfo Public of_SetResize

Public of_GetSaveStatus Protected of_SetUpdateable

Protected of_SetUpdateObjects

Protected of_SetupdateRequestor

of_Update

Protected of_UpdateChecks

of_UpdatePrep
of_UpdatesPending
of_Validation

Protected of_SetAlwaysValidate Public
Public of_SetBase Public
b pfc_w_response
L w_response
- Events
pfc_Apply pfc_Default
pfc_Cancel
PFCMAIN.PBL
PFEMAIN.PBL

Use w_response as the ancestor window for all response windows.

Add OK, Cancel, and window-specific CommandButtons to your w_response
descendant. Then add code to the CommandButtons' Clicked events to trigger
the appropriate w_response user event. Typically, Cancel triggers pfc_Cancel,
Apply triggers pfc_Apply, and OK triggers pfc_Default.

w_master

W_response includes predefined events:

pfc_Apply

| pfc_Default

pfc_Cancel

59



w_response

pfc_Apply

Description Empty user event to which you add code that applies dialog box specifications
to the associated sheet or window.

Usage Add code to this event to apply specifications to the associated sheet or
window. Trigger this user event from a cb_apply.Clicked event script.

Examples This example shows code you might add to pfc_Apply:

Integer 1li_cnt, li_arraysize, li_rc
Boolean 1b

ToolbarAlignment 1t

String 1s

// Set toolbar settings
1li_arraysize = UpperBound(istr_toolbar[])
FOR li_cnt = 1 to li_arraysize
istr_toolbar[li_cnt].w_owner.SetToolbar &
(istr_toolbar[li_cnt].i_barindex, &
istr_toolbar[li_cnt].b_visible, &
istr_toolbar[li_cnt].e_alignment, &
istr_toolbar[li_cnt].s_title)
istr_toolbar[li_cnt].w_owner.GetToolbar &
(istr_toolbar[li_cnt].i_barindex, 1lb, 1lt, 1s)
NEXT
// Set application toolbar settings
iapp_object.ToolbarText = cbx_text.checked
iapp_object.ToolbarTips = cbx_tips.checked
// Disable Apply button. Make OK the default
cb_apply.Enabled = False
cb_apply.Default = False
cb_cancel.Default = False
cb_ok.Default = True

pfc_Cancel

Description Empty user event to which you add code that closes the window without
accepting changes.

Usage Add code to this user event to close the window without accepting changes.
Trigger this user event from the cb_cancel.Clicked event script.
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Exampies

pfc_Default
Description

Usage

Examples

This example closes the window and passes a return value of 0:

CloseWithReturn (This, 0)

Event to apply changes and close a response window.

Add code to this event to apply changes and close a response window. It is
meant to be triggered by the default CommandButton (typicaily cb_ok), but it
could be triggered by Cancel, Close, or some other CommandButton.

This example shows code you might add to the pfc_Default:

SetPointer (HourGlass!)

SQLCA.dbms = "ODBC"
SQLCA.database = "expense"
SQLCA.logid = sle_userid.text
SQLCA.logpass = sle_password. text
SQLCA.dbparm = "Connectstring='DSN=" + &
SQLCA.database + ";UID=" + &
SQLCA.logid + ";PWD=" + SQLCA.logpass + "'"
IF SQLCA.of_Connect() <> 0 THEN
MessageBox ("Login Error", SQLCA.SQLErrText)
CloseWithReturn (This, 0)
ELSE
CloseWithReturn(This, 1)
END IF
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w_sheet

Description

Ancestry

Library

Object relationships

Usage

See also
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Ancestor for all PowerBuilder Foundation Class Library sheet windows.

This window contains automatic MicroHelp display capability.

pfc_w_master

w_master

[~ Events
Activate pfc_MicroHelp pfc_PreUpdate
Close pfc_MRUClicked pfc_Print
CloseQuery pfc_MRUProcess pfc_Printimmediate
Move :_MRURestore pfc_Save
Open pfc_MRUSave pfc_SaveAs
pfc_AcceptText >_New pfc_SaveObjects
pfc_BeginTran pfc_Open pfc_Update
pfc_Close pfc_PageSetup pfc_UpdateObjects
pfc_ControlGotFocus  pfc_PostOpen :_UpdatePrep
pfc_DBError pfc_PostUpdate pfc_UpdatesPending
pfc_Descendant pfc_PreClose pfc_UpdatesPendingRef
pfc_EndTran pfc_PreMRUSave pfc_Validation
pfc_Help pfc_PreOpen Resize
pfc_MessageRouter
Object functions
Public of_AcceptText Public of_SetDBErorMsg
Public of_GetCloseStatus Public of_SetLogicalUnitOfWork
Protected of_GetDWType Public of_SetPreference
Public of_Getinfo Public of_SetResize
Public of Prot of_Sett

1

Protected of_GetUpdateObjects Protected of_SetUpdateObjects
Protected of_IsAlwaysValidate Protected of_SetupdateRequestor
Protected of_IsUpdateable Public of_Update

I

Protected of_MessageBox Protected of_UpdateChecks
Public of_PostUpdate Public of_UpdatePrep
Protected of_SetAlwaysValidate Public of_UpdatesPending
Publi f_SetBase Public of_Validation
pfc_w_sheet
L w_sheet
Events
Activate pfc_MicroHelp

pfc_ControlGotfocus

PFCMAIN.PBL
PFEMAIN.PBL

n_cst_string
Use this window as the ancestor for all of your application's sheet windows.

If you want to display MicroHelp for controls within a sheet, associate the
MicroHelp text with each control's tag value. The control's tag value must
specify MICROHELP=microhelptext. When the control gets focus, the
pfc_ControlGotFocus event displays the tag text in the status bar.

w_frame
w_master
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Events

Activate
Description

Usage

W _sheet includes predefined events:

Activate
pfc_MicroHelp
pfc_ControlGotFocus

Sets MicroHelp to the control with focus.

This event executes whenever the window receives focus.

pfc_ControlGotFocus

Description

Syntax

Usage

pfc_MicroHelp

Description

Syntax

Usage

Displays the MicroHelp stored in the control's tag value.

This event extends the ancestor pfc_ControlGotFocus event.

instancename.EVENT pfc_ControlGotFocus ( control)

Argument Description

instancename | Instance name of w_sheet-based descendant

control DragObject variable containing the control that just got focus

This event is called by PFC visual controls when they get focus.
The control's tag value must specify MICROHELP=microhelptext.

Updates MicroHelp by calling the frame's pfc_MicroHelp event.

This event extends the ancestor pfc_MicroHelp event.

instancename.EVENT pfc_MicroHelp ( microhelp )

Argument Description
instancename Instance name of w_sheet-based descendant
microhelp String to be displayed in the status bar

This event executes whenever the sheet or a control on the sheet receives focus.
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About this chapter

Contents

Menus

This chapter describes the menus in the PowerBuilder Foundation Class
Library (PFC).

The menus are listed in alphabetical order. Each object’s discussion
includes alphabetical listings of instance variables, events, and object
functions.
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m_dw
Description Popup menu displayed when the user releases the right mouse button over a
u_dw based DataWindow control.
Ancestry pfc_m_dw
m_dw

Object functions

Public of_SetParent
Library PFCMAIN.PBL

PFEMAIN.PBL

Menu bar items

M_dw is a popup menu and has a single menu bar item:

Table

Table menu

Menu items Menu item Description
Cut Calls the pfc_Cut event
Copy Calls the pfc_Copy
Paste Calls the pfc_Paste event
Select All Calls the pfc_SelectAll event
Insert Calls the pfc_InsertRow event
Add Calls the pfc_AddRow event
Delete Calls the pfc_DeleteRow event
Restore Calls the pfc_RestoreRow event
Columns Calls the pfc_Columns event
Functions Calls the pfc_Functions event
Operators Calls the pfc_Operators event
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See also

Menu item Description
Values Calls the pfc_Values event
DataWindow Calls the pfc_Debug event
Properties
Properties Empty menu item. Add calls to functions or events that
display properties for a DataWindow column
u_dw

Instance variables

M_dw includes one instance variable:

Instance variable | Description | Data type | Access | Usage
idw_parent Owning DataWindow DataWindow Protected Used to access the
control. current DataWindow
control
Functions

of_SetParent
Description
Access

Syntax

M_dw includes one precoded object function:

of_SetParent

Establishes the current DataWindow control.

Public

instancename.of_SetParent ( currentdw )

Argument Description
instancename Instance name of m_dw
currentdw DataWindow variable identifying the DataWindow that opened

this instance of m_dw
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Return value
Usage

Examples

68

Integer. Returns 1 if the function succeeds and -1 if an error occurs.
U_dw calls this function to establish a relationship with m_dw.
This example is from the u_dw RButtonUp event:

1m_dw = create m_dw
1m_dw.of_SetParent (this)
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m_edit

Description

Ancestry

Library

Menu bar items

Edit menu

Menu items

See also

Popup menu displayed when the user releases the right mouse button over
certain PFC visual controls.

pfc_m_edit
[ m_edit

— Object functions
Public of_SetParent

PFCMAIN.PBL
PFEMAIN.PBL

M_edit is a popup menu and has a single menu bar item:

Edit

Menu item | Description

Cut Calls the pfc_Cut event for the current window or window control
Copy Calls the pfc_Copy event for the current window or window control
Paste Calls the pfc_Paste event for the current window or window control

Select All Calls the pfc_SelectAll event for the current window or window
control

m_view
u_mle
u_rte
u_sle
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Instance variables

M_edit includes one instance variable:

Instance variable | Description | Datatype | Access | Usage

idrg_current

Functions

of_SetParent
Description
Access

Syntax

Return value
Usage

Examples

70

Used to access the current
control

Current window or window | DragObject | Protected

control

M_edit includes one precoded object function:

of_SetParent

Establishes the current control.
Public

instancename.of_SetParent ( currentcontrol )

Argument Description

instancename | Instance name of m_edit

currentcontrol | DragObject containing the control that opened this instance of
m_edit

Integer. Returns 1 if the function succeeds and -1 if an error occurs.
PFC visual objects call this function to establish a relationship with m_edit.

This example is from the u_rte RButtonUp event:

Integer li_rc

m_edit 1m_edit

Window lw_parent
String 1ls_selectedtext

1lm_edit = create m_edit
1lm_edit.of_SetParent (this)
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m_frame
Description The m_frame menu is a descendant of m_master with most items disabled and
hidden. Use this menu as the frame menu for your application, modifying and
adding menu items as necessary.
Ancestry pfc_m_master
m_master
Object functions
Public of_SendMessage
m_frame
Library PFEWNSRV.PBL

Menu bar items

The m_frame menu has the following visible menu bar items:

File
Help
File menu
Menu items Menu item | Description
New Calls the pfc_New event for the frame window
Open Calls the pfc_Open event for the frame window
Exit Calls the pfc_Exit event for the frame window
Help menu
Menu items Menu item | Description
Help Topics | Calls the pfc_Help event for the frame window
About Calls the n_cst_appmanager of_About function
See also m_master
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m_Ilvs

Description

Ancestry

Library

Menu bar items

View menu

Menu items

Popup menu displayed when the user releases the right mouse button over a
ListView based on u_lvs.

pfc_m_Ivs
| m_lvs
L Instance variables

Protected ListView  ilv_parent

Object functions
Public of_SetParent

PFCMAIN.PBL
PFEMAIN.PBL

M_lvs is a popup menu and has a single menu bar item:

View
Menu item Description
View Changes the ListView display style. Options are:

¢ Largeicon
¢ Small icon
¢ List

¢ Report

Arrange Icons Sorts the display by the specified column

Select All Calls the pfc_SelectAll event

Invert Selection | Calls the pfc_InvertSelection event

Cut Calls the pfc_Cut event

Copy Calls the pfc_Copy event
Paste Calls the pfc_Paste event
Clear Calls the pfc_Clear event
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Menu item Description

New Calls the pfc_New event

Delete Calls the pfc_Delete event

Rename Calls the pfc_Rename event

Properties Calls the pfc_Properties event
See also u_lvs

Instance variables

M_lvs includes one instance variable:

Instance variable | Description | Data type | Access | Usage

Used to access the
associated ListView control

ilv_parent ListView control ListView Protected

displaying the popup menu.

Functions
M_lvs includes one precoded object function:

of_SetParent

of SetParent

Description Establishes the ListView control associated with an instance of the m_lvs
popup menu.
Access Public
Syntax instancename.of_SetParent ( listview )
Argument Description
instancename Instance name of m_lvs
listview ListView variable containing the ListView that opened this
instance of m_lvs
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Menus

Return value Integer. Returns 1 if the function succeeds and -1 if an error occurs.
Usage U_lvs calls this function to establish a relationship with m_lvs.
Examples This example calls the of _SetParent function:

if IsNull(lm_view) Or not IsValid(lm_view) then
1m_view = create m_1lvs
lm_view.of_SetParent (this)

end if
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m_master

Description

Ancestry

Library

Menu bar items

File menu

Menu items

76

Master menu for all PFC applications. Use this menu as the ancestor for your
application's menus.

pfc_m_master
m_master

Object functions
Public of_SendMessage

PFCWNSRV.PBL
PFEWNSRV.PBL

The m_master menu has the following menu bar items:

File
Edit
View
Insert
Tools
Window
Help

Menu item Description

New Calls the pfc_New event for the current window or window
control

Open Calls the pfc_Open event for the current window or window
control

Close Calls the pfc_Close event for the current window or window
control

Save Calls the pfc_Save event for the current window or window
control

Save As Calls the pfc_SaveAs event for the current window or window
control
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Menu item Description

Print Calls the pfc_Print event for the current window or window
control

Print Preview | Calls the pfc_PrintPreview event for the current window or
window control

Page Setup Calls the pfc_PageSetup event for the current window or window
control

Print Calls the pfc_PrintImmediate event for the current window or

Immediate window control

Delete Empty menu item. Add calls to function or events that perform
deletion

Properties Empty menu item. Add calls to function or events that display
properties

Exit Calls the pfc_Exit event for the current window or window
control

PFCMRU1 Calls the pfc_MRUClicked event for the current window or
through window control
PFCMRUS5S

Edit menu
Menu items Menu item Description
Undo Calls the pfc_Undo event for the current window or window
control
Cut Calls the pfc_Cut event for the current window or window
control
Copy Calls the pfc_Copy event for the current window or window
control
Paste Calls the pfc_Paste event for the current window or window
control

Paste Special | Calls the pfc_PasteSpecial event for the current window or
window control

Clear Calls the pfc_Clear event for the current window or window
control

Select All Calls the pfc_SelectAll event for the current window or window
control

77



m_master

View menu

Menu items

78

Menu item Description
Find Calls the pfc_FindDlg event for the current window or window
control
Replace Calls the pfc_ReplaceDlg event for the current window or
window control
Update Links | Calls the pfc_UpdateLinks event for the current window or
window control
Object>Edit Calls the pfc_EditObject event for the current window or
window control
Object>0Open | Calls the pfc_OpenObject event for the current window or
window control
Menu item | Description
Ruler Calls the pfc_Ruler event for the current window or window control
Large Icon | Empty menu item. Add calls to function or events that change
ListView display
Small Icon | Empty menu item. Add calls to function or events that change
ListView display
List Empty menu item. Add calls to function or events that change
ListView display
Details Empty menu item. Add calls to function or events that change
ListView display
Arrange Empty menu item. Add calls to function or events that arrange icons
Icons>By
Arrange Empty menu item. Add calls to function or events that arrange icons
Icons>Auto
Arrange
First Calls the pfc_FirstPage event for the current window or window
control
Next Calls the pfc_NextPage event for the current window or window
control
Prior Calls the pfc_PreviousPage event for the current window or
window control
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Insert menu

Menu items

Tools menu

Menu items

Window menu

Menu items

Menu item | Description

Last Calls the pfc_LastPage event for the current window or window
control

Sort Calls the pfc_SortDlg event for the current window or window
control

Filter Calls the pfc_FilterDlg event for the current window or window
control

Zoom Calls the pfc_Zoom event for the current window or window control

Menu item | Description

File Calls the pfc_InsertFile event for the current window or window
control

Picture Calls the pfc_InsertPicture event for the current window or window
control

Object Calls the pfc_InsertObject event for the current window or window
control

Menu item | Description

Customize Calls the pfc_Toolbars event for the current window or window

Toolbars control

Menu item Description

Cascade Calls the pfc_Cascade event for the frame window

Tile Horizontal | Calls the pfc_TileHorizontal event for the frame window

Tile Vertical Calls the pfc_TileVertical event for the frame window
Layer Calls the pfc_Layer event for the frame window
Minimize All Calls the pfc_MinimizeAll event for the frame window
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Help menu

Menu items

See also

Functions

of _SendMessage

Description

Access

Syntax

Return value

Usage

80

Menu item | Description

Undo Arrange ‘ Calls the pfc_UndoArrange event for the frame window

Menu item Description
Help Topics Calls the pfc_Help event for the current window or window
control
About Calls the n_cst_appmanager of_About function
m_frame
w_frame
w_master

The m_master menu includes one precoded object function:

of_SendMessage

Calls the n_cst_menu of_SendMessage function, which sends the passed
message to the current window through the pfc_MessageRouter event.

Public

instancename.of_SendMessage ( message )

Argument Description

instancename Instance name of m_master

message String specifying the user event to be triggered by the
pfc_MessageRouter event

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

PFC menu items call this function to trigger events on the associated window
and window controls.
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Examples This example is from the m_master File>Open menu item's Clicked event.

SetPointer (hourglass!)
of_SendMessage ("pfc_open")
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m_ocC

Description

Ancestry

Library

Menu bar items

Object menu

Menu items

See also

Popup menu displayed when the user releases the right mouse button over an
OLE control based on u_oc.

1 pfc_m_oc
m_oc
Object functions
Public of_SetParent

PFCMAIN.PBL
PFEMAIN.PBL

M_oc is a popup menu and has a single menu bar item:

Object
Menu item Description
Edit Calls the pfc_EditObject event for the OLE control
Open Calls the pfc_OpenObject event for the OLE control
Cut Calls the pfc_Cut event for the OLE control
Copy Calls the pfc_Copy event for the OLE control
Paste Calls the pfc_Paste event for the OLE control
u_oc

Instance variables

82

M_oc includes one instance variable:
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Instance variable | Description Data type Access Usage
ioc_parent OLE control displaying the | OLEControl | Protected Used to access the
popup menu. associated OLE control.

Functions

of_SetParent

Description

Access

Syntax

Return value
Usage

Examples

M_oc includes one precoded object function:

of_SetParent

Establishes the OLE control associated with an instance of the m_oc popup

menu.

Public

instancename.of_SetParent ( olecontrol )

Argument Description

instancename Instance name of m_oc

olecontrol OLEControl variable containing the OLE control that opened
this instance of m_oc

Integer. Returns 1 if the function succeeds and -1 if an error occurs.

U_oc calls this function to establish a relationship with m_oc.

This example calls the of_SetParent function:

m_oc Im_oc

String ls_selectedtext

lm_view = create m_oc

1lm_view.of_SetParent (this)
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m_tvs
Description Popup menu displayed when the user releases the right mouse button over a
TreeView based on u_tvs.
Ancestry pfc_m_tvs
m_tvs

Object functions

Public of_SetParent
Library PFCMAIN.PBL

PFEMAIN.PBL

Menu bar items
M_tvs is a popup menu and has a single menu bar item:

View

View menu

Menu items Menu item | Description
Open Calls the pfc_Open event
Find Calls the pfc_FindDlg event
Cut Calls the pfc_Cut event
Copy Calls the pfc_Copy event
Paste Calls the pfc_Paste event
Clear Calls the pfc_Clear event
New Calls the pfc_New event
Delete Calls the pfc_Delete event
Rename Calls the pfc_Rename event
Properties Calls the pfc_Properties event

See also u_tvs
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instance variabies
M_tvs includes one instance variable.
Instance variable | Description | Data type | Access | Usage
itv_parent TreeView control TreeView Protected Used to access the
displaying the popup menu. associated TreeView
control
Functions

of SetParent

Description

Access

Syntax

Return value
Usage

Examples

M_tvs includes one precoded object function:

of_SetParent

Establishes the TreeView control associated with an instance of the m_tvs
popup menu.

Public

instancename.of_SetParent ( listview )

Argument Description

instancename Instance name of m_tvs

listview TreeView variable containing the TreeView that opened this
instance of m_tvs

Integer. Returns 1 if the function succeeds and -1 if an error occurs.
U_tvs calls this function to establish a relationship with m_tvs.

This example calls the of_SetParent function:

im_view = CREATE m_tvs
im_view.of_SetParent (this)
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About this chapter

Global Functions

This chapter describes the global functions in the Powersoft Foundation
Class Library (PFC).
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f_SetFilesrv

f_SetFilesrv

Description

Access

Syntax

Return value

Usage

Examples

See also

88

Enables or disables the platform-specific file-handling service. The file service
is implemented through the n_cst_filesrv user object and its descendants.

This function creates an operating system-specific descendant of n_cst_filesrv:
¢ Windows 3.1 n_cst_filesrvwinl6

¢ Windows 95 and Windows NT n_cst_filesrvwin32

¢ Macintosh n_cst_filesrvmac
¢

UNIX n_cst_filesrvsol2, n_cst_filesrvaix, or n_cst_filesrvhpux<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>